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自动对接 

 

引言 

Autodock 是一个用于预测配体和生物大分子靶标之间相互作用的自动化程序。开发这一程序的灵感源于设计生

物活性化合物中遇到的问题，特别是计算机辅助药物设计领域。生物大分子的 X-射线衍射技术的进步为我们提

供了更多重要的蛋白和核酸分子的结构。这些结构可以作为生物活性物质的靶标，用于控制动植物的疾病，或

者可以使人们简单的理解活性物质在生物学方面的作用机理。准确的了解蛋白靶标和这些活性小分子之间的相

互作用是十分重要的。因此，我们的目标就是为科研工作者提供一个计算工具，帮助他们研究蛋白质与小分子

复合物的相互作用。 

任何对接计算都有两个相互矛盾的方面需要平衡：在尽可能精准的计算与合理（有限）的计算资源之间达到一

个平衡。理想的步骤是通过搜索整个系统可能的自由度，在底物和目标蛋白的结合能中找到全局能量极小值。

然而这样的工作只能在大型的工作站上实现，并且耗费和结构生物学家进行晶体结构修饰相当的时间。为了解

决这一问题，很多对接软件简化了对接的步骤。Autodock 通过两种方法的结合使用解决了以上的问题：快速的

基于格点能量的计算方法(rapid grid-based energy evaluation)和有效的扭转自由度搜索方法(efficient search of 

torisional freedom)。 

此教程介绍了 Autodock 使用的方法（原理）和文件格式，同时也提供了如何使用 AutoDockTools 生成对应的文

件以及分析结果的方法。 
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开始使用 Autodock 

生物分子模拟论坛（www.bioms.org）为各位愤青提供一个纯学术交流平台，我们倡导 Free 的分享精神，让大家在一个浓郁的学术

氛围中讨论和交流。此 AutoDock 译文则是在这种精神的鼓舞下应运而生的。在此感谢各位译者的无私奉献！ 

  

本译文为第一版，参与者均为各高校的在读硕士、博士，也有言不达意之处，希望各位读者将发现的问题或疑问及时反馈到生物分

子模拟论坛的分子对接板块上。我们的志愿者将不定期的对教程进行修改和完善，并添加相应的使用实例，尽请期待！ 

 

AutoDock 和其图形化界面准备工具 AutoDockTools 可在以下网址获得： 

http://autodock.scripps.edu/ 

 

该站点同样包括众多关于 AutoDock 使用的资源，包含详细的 AutoDock 基础使用教程，柔性环状结构的配体对

接教程以及利用 AutoDock 进行虚拟筛选的教程。可以在下列网址获得： 

http://autodock.scripps.edu/faqs-help/tutorial 
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AutoDock 的计算通过以下几步实现： 

1． 使用 AutoDockTools 准备体系的坐标文件（PDBQT 文件）， 

2． 使用 AutoGrid 预算原子亲和力， 

3． 使用 AutoDock 把配体对接入受体的活性位点， 

4． 利用 AutoDockTools 对结果进行分析。 

 

步骤 1-体系坐标文件的准备。AutoDock4.2 的坐标参数文件仅使用蛋白、配体和其极性氢原子的坐标。PDBQT

格式（PDB 的一种扩展格式）文件被用于保存体系的坐标。PDBQT 文件中还包含了原子的部分电荷以及原子类

型。现有的 AutoDock 力场对于 常见的原子采用几种不同的原子类型进行描述，比如区分了脂肪族的 C 原子和

芳香环 C 原子， 区分了形成氢键的极性原子与不形成氢键的极性原子。PDBQT 文件也包含关于扭转自由度的相

关信息。当蛋白质中的一些特定残基的侧链被考虑为柔性残基时，软件会生成一个单独的 PDBQT 文件用于描述

侧链的坐标信息。在绝大多数情况下，AutoDockTools 将从传统的 PDB 文件生成 PDBQT 文件。 

 

步骤 2-AutoGrid 格点能的计算 

快速的能量计算通过预算对接配体分子中的每个原子类型的亲和力得以实现。在 AutoGrid 步骤中蛋白质被嵌入

一个三维网格中，在每个格点上放置一个探针原子。这个原子与蛋白的相互作用能量被赋予该格点。AutoGrid

计算的格点亲和力包括配体中每种原子类型的亲和力，典型的有碳、氧、氮、氢原子类型，当然还包括了静电

势能和去溶剂化效应。在之后的 AutoDock 的计算过程中，指定的配体构象能量将通过格点能量值进行计算。 

 

步骤 3-使用 AutoDock 进行对接。对接过程中将使用多种构象搜索方法中的一种， 有效的方法是拉马克遗传算

法(LGA)，但是传统的遗传算法和模拟退火的方法也可以用于构象搜索。对于典型的系统，AutoDock 通过数次

运行得到数个对接后的构象，然后结合预测能量的分析与结果的一致性来找到 合理的构象。 

 

步骤 4-使用 AutoDockTools 进行分析。AutoDockTools 包括一系列用于分析对接结果的方法，其中有根据构象相

似性进行的聚类分析，构象可视化分析，配体-蛋白相互作用可视化分析以及由 AutoGrid 得到的亲和力可视化分

析。 

 

新版本更新内容 

 

AutoDock 4.2 与 AutoDock 3.0 相比强化的地方： 

 

侧链的柔性化处理：AutoDock 4.2 允许考虑受体上有限的侧链柔性。这一特性是通过将受体分成两个文件来实现

的。刚性的部分通过 AutoGrid 进行能量估算，柔性的部分使用和对柔性配体一样的方式进行处理。 

 

Administrator
高亮

Administrator
下划线

Administrator
下划线
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力场：AutoDock 4.2的力场可用于估算配体结合到受体上的结合自由能。这一力场包括了一个升级的基于电荷的

去溶剂化项，改进了的氢键指向性和对于未结合状态的模型。 

 

扩展的原子类型：系统添加了卤素原子和常见的金属离子类型，并为其生成了对应的参数文件。 

去溶剂化模型：去溶剂化模型现已支持系统所有的原子类型，而不像以前只支持碳原子。因此，AutoGrid 已不

再使用 constant 函数，因为极性原子的去溶剂化已经可以处理。新的模型需要用 AutoGrid 计算生成一个新的

map 文件，这一文件包含了基于电荷的去溶剂化信息。 

 

未结合态：有一些模型可用于估算未结合态体系的能量，包含了一个扩展的模型和一个将未结合态作为类似于

蛋白结合态处理的模型。 

 

 

AutoDock4.2 针对于 Autodock4.0 的更新： 

 

默认的未结合态：未结合态的默认模型已经将从”extend”转变成”bound=unbound”。这是为了解决之前立体位阻

较大的配体的问题。通过调用关键词”unbound extended”，之前的”extend”模型任可在 AutoDock4.2 中使用，。 

 

兼容性：我们确保在 AutoDock4.0 中可用的对接文件同样可在 AutoDock4.2 中使用。 

 

软件技术支持 

AutoDock 是免费软件，但是由于支持经费有限，我们不能对安装和使用中出现的具体问题进行快速的响应。虽

然这里有一份 AutoDock 使用教程，但是同样需要用户具有一些 Unix 的基本知识。如果你还需要一些帮助的

话： 

1. 找你当地懂 Unix 的人帮忙 

2. 登录 AutoDock 的 FAQ 网站： 

http://autodock.scripps.edu/faqs-help 

3. 如果你不能找到你问题的答案，把你的问题提交到 AutoDock 的 List (ADL)或者 AutoDock 的论坛上。那里有

很多计算化学软件使用高手和一些可能知道你问题答案的 AutoDock 的用户。你可以在下列网址找到 ADL 的更

多信息: http://mgldev.scripps.edu/mailman/listinfo/autodock 

AutoDock的论坛网站为：http://mgl.scripps.edu/forum 

4. 如果以上的方法你尝试了都不行，请给 goodsell@scripps.edu 发邮件询问 AutoGrid或者 AutoDock的相关问题，或

者给 rhuey@scripps.edu发邮件询问 AutoDockTools的相关问题。 
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谢谢您的理解！ 

 

E-mail address 

Arthur J. O1son, Ph. D. o1son@scripps.edu 

David S. Goodsell, Ph. D. goodsell@scripps.edu 

Ruth Huey, Ph. D. rhuey@scripps.edu 

 

Fax: +(858) 784-2860 

The Scripps Research Institute, 

Molecular Graphics Laboratory, 

Department of Molecular Biology, Mail Drop MB-5, 

10550 North Torrey Pines Road, 

La Jolla, CA 92037-1000, U. S. A.
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ij

理论基础 

自由能函数的概述 

AutoDock 4.2 使用一种半经验的自由能力场估算对接模拟中的构象。该力场的参数是由大量蛋白质-抑制剂

复合物相关数据进行拟合得到，这些抑制剂结构已知且抑制常数 Ki也已测得。 

 

 

通过力场估算结合自由能分两步进行。配体和蛋白起始时处于未结合态。第一步是通过未结合态到结合态时

配体和蛋白的改变估算分子内能量。第二步是通过结合态时蛋白和配体间的相互作用估算分子间能量。 

力场包含了 6 对估算值(V) 和在结合过程中损失的构象熵变 (ΔSconf)： 

其中 L 代表配体，P 代表受体（如蛋白）。 

每对估算值（V）都包含了分散-排斥能，氢键能，静电势能和去溶剂化自由能。 

 

 
 


 
 

Administrator
打字机
分子内的



9 

 
 
 
 

生物分子模拟论坛                                                                                                                                                                          www.bioms.org 

 

权重常数 W已经由一系列实验测定的结合常数进行过优化，用于校正经验自由能。第一项是典型的 6/12势用

于描述分散-排斥能，这项参数是基于 AMBER力场的。第二项是基于 10/12势的氢键项。参数 C和 D用于指定由

N和 O作为氢键受体形成的距离为 1.9 Å的氢键的 大的势阱深为 5 kcal/mol, 以及由 S作为氢键受体形成的距离为

2.5 Å的氢键的势阱深为 1 kcal/mol。函数 E(t)项指明了氢键方向性，以实际形成氢键与理想氢键构象的角度 t为自

变量。第三项是用于描述库伦势中经过筛选得到的静电势能。 后一项是基于原子体积（V）的去溶剂化自由能

项，由溶剂化参数（S）和指数项中距离权重因子 ó（ó=3.5 Å）作为权重系数。对于这个函数的详细解释，请阅

读附录 2中的参考文献。 

默认情况下， AutoGrid 和 AutoDock 使用了力场标准的参数和权重集。 但“parameter_file” 关键词可以使用

用户自定义的参数文件。参数文件的格式见附录 I。 

 

用 AutoDockTools 观察格点。蛋白在左侧用白色的键表示，网格在右侧显示。蓝绿色区域是 适合碳原子结合

的区域，红色区域是 适合氧原子结合的区域。配体位于盒子的右上方。 
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AutoDock 的势：在上图中表现出了 AutoDock 力场中的 4 种贡献。分散/排斥势表示的是两个碳原子之间的相互

作用。氢键势显示的是 O 与 H 原子的相互作用，其 小值约为-2 kcal/mol。 静电相互作用势显示是两个带全原

子电荷的相反电荷原子间的相互作用。去溶剂化势表示的是一个 C 原子在每个距离处有 10 原子替换水分子得到

的能量。 
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使用 AutoDock 
 
第一步：准备坐标文件 

 
第一步是准备配体和受体的坐标文件，这些坐标文件包含的信息是执行 AutoGrid 和 AutoDock 所必要的。

这些坐标文件被转化成 AutoDock 特定的坐标文件格式（PDBQT），它包括了： 

1）极性氢原子； 

2）局部电荷； 

3）原子类型 

4）柔性分子的节点信息。 

对于一个典型的对接计算，将会分别生成一个受体和配体坐标文件。如果在对接过程中选择受体的氨基酸

侧链为柔性，将会生成第三个文件，该文件包含了受体柔性部分的原子坐标。 

在一个典型的研究中，用户使用 AutoDockTools 只需以下几步就可准备好坐标文件。 初两步可以用

AutoDockTools 菜单栏中编辑（Edit）工具或者使用其他的分子模拟程序就可以完成。 

1）给分子添加所有氢。 

2）添加局部电荷。 

然后，点击 Ligand 菜单导入配体，点击 Grid 菜单导入受体，AutoDockTools 将生成 PDBQT 文件。 

 3）删除非极性氢，将它们所带的电荷与碳原子所带的电荷合并。 

4）指定原子类型，定义氢键受体和供体以及芳香和脂肪族碳原子。 

5）选择一个根（root）原子， 以它作轴点旋转柔性分支。 

此步骤定义了旋转键并建立扭转树。 

在这个过程中有几点值得注意： 

目前 AutoDockTools 和 PMV 使用 Babel 来添加氢原子和赋予电荷。然而不幸的是 Babel 处理一些分子有困

难。在这种情况下，氢的位置和电荷可能要通过用户熟悉的方法来设定，例如使用 Reduce，InsightII，Quanta，

Sybyl，Amber 或者 CHARMm。 

此外，许多模拟体系添加极性氢原子时是以默认的方向，通常假定每个新扭转角为 0°或 180°。如果没有某

种精细化的形式，它可能导致氢键的位置错误。一种方法是对结构执行松弛氢原子并且进行分子力学的优化。

另一种方法就是使用像 “pol_h”的程序，该程序可以添加默认极性氢原子，给每个移动的质子有利的位置并且选

择 好的位置，这种智能处理可移动极性氢原子，这一点对于酪氨酸，丝氨酸和苏氨酸形成氢键特别重要。 

当 PDB 文件含有无序的氨基酸残基的时候，将在备用位置（17 列）被标示出。对于每个这样的原子，用

户必须从可能的位置中选择一个，确保所选择设置的局部一致性。 

注意：在对接计算中，坐标的准备是 重要的一步。对接结果的质量和准确性将会与开始准备的坐标的质

量相关。请仔细检查氢原子的位置，指定的原子类型，局部电荷以及分子的完整性，以确保它们的化学意义。

如果你使用的是 AutoDockTools 中的 Babel 方法来添加电荷和氢原子，有必要的话，应该仔细检查结果并进行
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修改——通常 AutoDockTools 中的 Babel 方法在处理分子时会出现问题，例如对核苷酸的处理。 

 
使用 AutoDockTools 生成 PDBQT 文件 
 

AutoDockTools 概述 
 

AutoDockTools 是用 Python Molecular Viewer (PMV)执行一系列命令，可从以下网址下载： 

http://autodock.scripps.edu/resources/adt 

 

AutoDockTools 窗口有几个部分： 

1) PMV 顶部菜单中有常用操作的工具。其中包括经常使用的读写坐标文件和图像，修改坐标，选择对象以及可

视化工具等。 

2) 一排按钮，可快速使用 PMV 常用的工具。 

3）在按钮的下面，AutoDockTools 有一系列菜单可使用 AutoDock 的特定工具。 

4）三维分子显示器在中间。 

5）位于显示器的下面的板块（Dashboard）可以快速的选择，可视化和着色当前显示的分子。 
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添加/删除 氢原子和电荷 

这些 PMV 中的工具可读取 PDB 格式或者其他格式的坐标，添加氢原子，选择分子的某部分以及添加局部

电荷。这些功能都是使用 PMV 窗口顶部的菜单栏中的工具实现的。这里将介绍一些有用的命令——PMV 其它

更多的信息，请看参阅 PMV 说明书。 

File>ReadMolecule：打开一个对话窗，导入 PDB 文件。 

Edit>Delete：删除整个分子、选择的原子或者氢原子。 

Edit>Hydrogens>Add：使用 Babel 添加所有或者极性氢原子。 

Edit>Charges:使用 Babel 计算任意分子的 Gasteiger 电荷 

 

配体 PDBQT 文件——“ligand”菜单 

一旦含有氢原子和电荷的配体信息被计算出来，就可以从 Ligand 菜单中生成配体的 PDBQT 文件。 

Ligand>Input>QuickSetup:使用默认的方法生成 PDBQT 文件。PDB 文件可以从 PMV 显示器或从文件中读取并且

可直接写入一个新的 PDBQT 文件。请注意氢原子将不会被添加。 

Ligand>Input>Open:  从文件中读入坐标。 

Ligand>Input>Choose:选择一个已经读入 PMV 中的分子。 

Ligand>Input>OpenAsRigid: 读入一个已经存在的 PDBQT 文件，然后生成一个无扭转分支的文件。 

TorsionTree>ChooseRoot: 手动选择一个根原子。  

TorsionTree>DetectRoot:自动检测根原子（root）。 

TorsionTree>ShowRootExpansion:对于分子中存在多个根原子的情况，以小球的形式显示作为根的所有原子，这

包括与根原子以刚性键相连的原子。 

TorsionTree>ShowRootMarker: 让根原子以小球形显示。 

TorsionTree>ChooseTorsions: 启动一个对话窗口以选择可旋转的键。可旋转的键显示为绿色，不可旋转键显示为

红色。潜在的可旋转键被默认为是刚性的，例如酰胺键以及那些被用户处理为刚性的键，显示为粉红色。可旋

转键和不可旋转键可以通过鼠标双击来切换。 

TorsionTree>SetNumberOfTorsions: 通过选择保留特定的键作为可旋转的方法来设置配体中旋转键的总数。该选

项中的两个子选项可以分别选择在配体中涉及 少原子数的扭转或者 多原子数的扭转。 

AromaticCarbon>SetNames:点击原子可以使其在芳香和脂肪碳原子类型间切换，芳香碳原子显示为绿色。确定

后点击“Stop”结束。 

AromaticCarbon>AromaticityCriterion:设置 AutoDockTools 用于识别芳香环碳原子的偏离角度。 

Ligand>Output:打开窗口，保存 PDBQT 文件。 

 

刚性受体 PDBQT 文件——Grid 菜单 

对于使用刚性受体的对接，首先在 PMV 中添加氢原子和电荷，然后使用 Grid 菜单读入坐标文件到
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AutoDockTools 中。 

Grid>Macromolecule>Open:打开对话窗，导入受体的 PDBQT 文件。 

Grid>Macromolecule>Choose:选择已导入 PMV 中的分子。ADT 将会自动合并非极性氢原子和电荷，指定芳香碳

原子，然后提示用户保存 PDBQT 文件。 

 

柔性受体 PDBQT 文件——柔性残基菜单 

对于考虑受体中柔性残基的对接，首先在 PMV 中添加氢原子和电荷，然后使用 ADT 生成两个 PDBQT 文

件。（一个是包含受体的刚性部分的文件，另一个则是仅含有受体柔性残基部分的文件）。 

FlexibleResidues>Input>OpenMacromolecule: 打开对话窗，导入受体的 PDBQT 文件。 

FlexibleResidues>Input>ChooseMacromolecule: 选择已导入 PMV 中的分子。ADT 将会自动合并非极性氢原子和

电荷，指定芳香碳原子，然后提示用户保存 PDBQT 文件。 

FlexibleResidues>ChooseTorsionsInCurrentlySelectedResidues:使用 PMV 菜单中的 select 工具选择柔性残基。然后

此选项用来指定这些残基为柔性化残基。对于这些残基你可以像处理配体似得通过双击键来选择哪些键需要保

持可旋转。 

FlexibleResidues>Output>SaveRigidPDBQT: FlexibleResidues>Output>SaveFlexiblePDBQT:这两个命令启动对话窗

口，保存受体的刚性部分和柔性部分的 PDBQT 文件。 
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第二步：运行 AutoGrid 
 

对接需要预先计算对接配体中的每一个原子类型的格点 map。这有助于加快对接的速度。这些格点 maps 由

AutoGrid 计算得到。一个格点 map 由三维晶格的周期性空间点阵组成，含盖了（全部或部分）大分子的活性位

点。这些大分子可能是一个蛋白，酶，DNA，RNA 或者甚至是聚合物或者离子晶体。一般格点的间距离是

0.2~1.0Å，且默认值是 0.375Å（大约是 C-C 单键长度的四分之一）。格点 map 的每一个点都储存了探针原子或

者官能团与大分子中所有原子间的势能。 

AutoGrid 需要一个格点参数文件来指定。这个格点参数文件通常以.gpf 为后 。就像下面描述的一样，

AutoDockTools 将被用来生成格点参数文件。所有对格点参数文件的描述都包含在附录一中。 

执行 AutoGrid 的命令如下： 

% autogrid4 -p macro.gpf [-l macro.glg] 

其中 ‘-p macro.gpf’指定格点参数文件，‘-l macro.glg’ 指定格点计算期间的记录文件。如果没有指定记录文件，

那么计算的过程记录就会显示到终端。 

AutoDock 希望使用 ASCII 格式的格点 maps，因此 AutoGrid 以可读性和可移植的 ASCII 码的格式输出格点

maps。了解关于格点 maps 文件格式，请见附录一。检查每个格点 map 的 小和 大能量：它们位于 AutoGrid

记录文件的 末端（就是在 “macro.glg”文件的末尾）。 小范德华能和氢键结合能一般在-10~-1kcal/mol，然而

大范德华能可达到+105 kcal/mol。静电势能的范围大约从 -103~+103 kcal/mol/e：如果它们都为 0，请确保已

经对大分子指定了局部电荷。 

除了格点 maps 之外，AutoGrid 也生成扩展名为‘.fld’和‘.xyz’的另外两个文件。前者是对格点文件的力场概

述，后者是在笛卡尔坐标中描述了格点的空间范围。 

 

在 AutoDockTools 中生成格点参数文件 
 

在 AutoDockTools 中 grid 菜单栏中的工具可用来生成格点参数文件。 

Grid>OpenGPF:从已经存在的格点参数文件中获取参数。 

Grid>Macromolecule:里面有选项可以导入一个已有的 PDBQT 文件或者选择已经读入 PMV 中的分子。 

Grid>SetMapTypes:该工具可以为定义所需计算的格点的原子类型。格点对配体中的每一个原子类型进行计算，

如果受体中使用了柔性侧链，他们的原子类型也必须包含在内。Directly 选项可以让用户直接输入原子类型列

表。其他选项可以让用户定义已经读入 PMV 中的基于配体或柔性残基的原子类型，或者打开配体、柔性残基

的 PDBQT 文件以及在这些文件中使用这些原子类型。 

Grid>SetMapTypes>SetUp CovalentMap: 对生成的共价图指定参数文件，它可用于使一个给定的配体原子在单独

的位置上结合。这特别适合用于对配体、受体复合物之间的共价对接。这将用高斯较好的计算一个给定坐标的

独立原子类型为“Z”的格点。在周边区域该位点上的势能将会从 0 升到能垒的 高点。 
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Grid>GridBox: 启动交互式命令以设定格点尺寸和中心。在指轮中输入数字可把光标放在滚轮上并且输入新的

值。在滚轮上右击可以得到更多的选项。重点是：当设置结束后，使用格点选项面板中 File 菜单中的“close 

saving current”选项保存。在浏览窗口的 Center 菜单中的选项可提供不同的方法，来选择个点盒子的中心。 

Grid>OtherOptions: 允许详述和编辑已经存在的参数文件。 

Grid>Output: 写出新的格点参数文件。 

Grid>EditGPF:对格点参数文件交互式编辑，可以浏览 近通过 AutoDockTools 写出的格点参数文件。
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第三步：使用 AutoDock 进行对接 

AutoDock 使用几种构象搜索计算中的一种来探测柔性配体的构象状态，在对接计算中，使用 AutoGrid 生

成的格点图来评价每一个点中配体-受体相互作用。在典型对接中，用户将执行多次对接操作，以获取多种对接

构象。将对接结果进行聚类分析，以鉴别类似构象——在分析部分，聚类分析将会详细的描述（第四步，见下

面）。 

AutoDock 需求：1)由 AutoGrid 计算的每个配体原子类型格点图，2）一个配体 PDBQT 文件以及 3）对接参

数文件，指定对接计算的文件以及参数。AutoDockTools 可以用来生成对接参数文件，就像下面描述的一样，

该文件一般的扩展名为.dpf。对接参数文件的全部描述在附录一中。 终对接参数文件被写入对接记录文件

中。就像下面步骤四描述的一样，这些对接构象可以应用 AutoDockTools 显示观察。他们（构象）可能使用

AutoDockTools 被写成 PDBQT 文件或者使用文本编辑直接从对接记录文件中得到。 

一个对接计算起始于使用下面的命令行： 

% autodock4 [-k][-i][-u][-t] -p lig.dpf [-l lig.dlg] 

参数文件的输入用“-p lig.dpf”来指定，包含输出和结果的对接文件的记录文件通过 “-l lig.dlg”来指定。这是正常

使用 AutoDock 以及执行标准的对接计算。 

-p dpf_filename 

指定对接参数文件 

-l dlg_filename 

指定对接记录文件。如果被忽略，文件就会被输出到终端并且对接结果将不会保存。 

-k 

保证输入配体 PDBQT 文件的原来的残基数。通常 AutoDock 对残基位置从残基数 0 起始重新编号，并且根据它

们的排序，（排序 1 是 低能量的簇）任何簇残基代表从 1 开始逐渐递增的被编号。 

-i 

-i 用来忽略任何格点图的文头错误，该错误可能引起文件名的冲突。这样忽略了通常要执行的对文头的检测，

以确保被使用的格点图的兼容性。 

-u, -h 

     这将返回一个帮助消息，描述 AutoDock 命令行的使用方法。 

-t 

-version 

版本 

这将返回一条描述所用的版本信息。 

 

为你的应用选择一个操作流程 
AutoDock 为进行的对接模拟提供了许多不同的方法，并且不同的方法可能有不同的应用。这部分包含了对

于选择 好方法的指导方针。 



10  

 
 
 
 

生物分子模拟论坛                                                                                                                                                                          www.bioms.org 

 

1）构象搜索：AutoDock 为进行构象搜索提供了多种方法。当前，拉马克遗传算法为一般应用提供了 有效的

搜索方法，是大多数情况下使用的技术。对于配体中可旋转键约为 10 的体系通常是有效的。遗传算法也可在没

有局部搜索下运行，但是它的效率不如拉马克遗传算法-局部相结合的方法。模拟退火的效率也不如拉马克遗传

算法，但是它应用在搜索起点为指定的点开始是有用的。局部搜索可以用于在局域环境下优化特定的分子。 

2）评价数：每一个搜索方法包括了应用在搜索中的参数以确定计算的工作量。在遗传算法中，这个参数是

ga_num_evals，在模拟退火中的参数是 nacc 和 nrej。这些默认的参数值对于有 10 个或更少的旋转键的对接系统

是足够的，更短的模拟可能通常用在旋转键非常少的体系中。对于有更多旋转键的复杂体系，简单的增加评价

总数通常是无效的。然而， 好是寻找更简单的体系构成法，例如将大体型配体分成两部分并且分别对接，或

者在可能的构象里固定一些旋转键。 

3）未结合的配体模型：为了估算结合自由能，AutoDock 需要估算未结合状态中的配体和蛋白的能量。对于这

一点有几种选择方法。默认情况下，AutoDock4.2 假设为未结合的配体和蛋白与复合物中的配体和蛋白的构象

是一样的。因为这两种构象是一样的，那么内部能量（配体或受体原子内部之间的相互作用）对总能量的贡献

是 0，并且在对接记录文件能量分解部分的第四行进行记录。 

AutoDock4.0 使用了不同的模型，其中配体假定为在溶液中扩展的状态，并且在对接模拟执行前能量是以

扩展的状态来计算的。这些模型可能在 AutoDock4.2 中通过关键词来使用。 

 “unbound_model_extended.”这些关键词将会启动扩展模型的计算，然后将会报告配体未结合模型的内部能量与

结合到蛋白时的内部能量的不同。在研究中许多同一配体独立的对接被执行，这种对于扩展模型配体的能量可

能被预先计算，然后用过关键词“unbound_model_extended_energy VALUE.”用在自由能计算中。 

用户可能使用 AutoDock 之外的其他方法来计算配体未结合能。在这种情况下，关键词 “unbound_energy 

VALUE” 可能用来设定为所希望的未结合状态的内部能量。这个值将会被使用在结合于未结合不同状态下以估

算自由能。 

4）特殊情况。AutoDock4.2 对于一些专门的应用包含了许多可选择的方法。例如，对于内部能量的计算而言，

关键词 intnbp_r_eps 忽略标准参数。这已经用于模拟柔性环状分子，但是在对接模拟中产生一组特殊的原子类

型来关闭环。（这种方法的更多详细描述在 AutoDock 万维网站的教程中。）其他可选功能包括添加旋转禁阻

的方法以及对力场和分析选项的修改。 

 

在 AutoDockTools 中生成对接参数文件 

在 AutoDockTool 的 Docking 菜单中的可用工具可以用来生成对接参数文件。 

Docking>OpenDPF:从已经存在的对接参数文件中获取参数。 

Docking>Macromolecule>SetRigidFilename: Docking>Macromolecule>SetFlexibleResiduesFilename:这两个命令指

定将会被用到的刚性受体的 PDBQT 文件名，如果使用了柔性受体残基，将会指定受体的柔性部分的 PDBQT 文

件名。 

Docking>Ligand>Open:这两个命令让用户选择已经读入 ADT 中的一个配体，或者打开一个已经存在的 PDBQT



10  

 
 
 
 

生物分子模拟论坛                                                                                                                                                                          www.bioms.org 

 

文件。 

Docking>Ligand>Ligand_Parameters:打开一个板块以设定不同的配体参数，包括平动、翻转和扭转角度的初始

值。详细参见附录一，对接参数文件的具体描述。 

Docking>SearchParameters>GeneticAlgorithmParameters: Docking>SearchParameters>SimulatedAnnealingParameters:

设定用于每一个搜索算法参数的面板，例如模拟退火中的温度计划表和遗传搜索中的变异概率以及交叉概率。

详细请参见附录对它们的全面描述。 

Docking>DockingParameters:在对接计算中，用来打开一个设置参数的面板，包括随机数发生器选项，立场选

项，当生成新的构象时的需要的步长，输出选项。对于每个详细的参数，见附录一对它们的全面的描述。 

 Docking>OtherOptions: 如果使用的话，指定外部原子参数文件名。 

Docking>OutPut>LamarckianGA: Docking>OutPut>GeneticAlgorithm: Docking>OutPut>SimulatedAnnealing: 

Docking>Output>LocalSearch: 

这四个命令都可输出对接参数文件，使用这四个方法中的一个搜索方法就行。 

Docking>Edit:对对接参数文件的交互式编辑器， 可以用来浏览 近由 AutoDockTools 生成的对接参数文件。
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第四步：评价对接结果 

在对接模拟的 后，AutoDock 将对每一个对接构象的坐标文件写入对接记录文件中，包括聚类和相互作用

能的信息。AutoDockTools 为分析对接记录文件中储存的信息提供了选项。 

 

对接记录文件中的信息 

在对接参数文件中的 analysis 命令可使 AutoDock 对不同的对接构象执行群集分析。其分析结果以柱状图的

形式报告出来，在对接的记录文件中，柱状图可以通过搜索词“HISTOGRAM”找出来（所有字母都要大写）。 

然后 AutoDock 对每一个簇中预测出能量 好的构象输出坐标（包括关键词 write_all，输出所有对接参数文

件中的所有构象坐标）对于每一个构象的文头，包括了预计的结合能信息，分解成的几个成分，以及构象的状

态变量信息。坐标被输出成修改后的 PDB 格式，其中四个实际值附加在 x,y,z 坐标的后面：原子间的范德华和

氢键相互作用能，原子间的静电相互作用，部分电荷以及相对于参照对象的 RMSD 值。 

 

使用 AutoDockTools 分析对接结果 

在 AutoDockTools 的“Analyze” 分析菜单中的选项可用来处理和分析对接模拟的结果。 

Analyze>Dockings>Open: 打开一个对接记录文件。 

Analyze>Dockings>OpenAll: 打开目录中的一组对接记录文件。 

Analyze>Dockings>Select:从之前输入 AutoDockTools 中的一组记录文件进行选择 

Analyze>Dockings>Clear: 清除已经读入 AutoDockTools 中的记录文件 

Analyze>Dockings>ShowAsSpheres:在每个对接构象质量中心（质点）生成一个球，这个球可能根据预测的相互

能量来着色。 

Analyze>Dockings>ShowInteractions: 生成一个专门可视化窗口以突出显示对接后的配体构象与受体之间的相互

作用。默认情况下，配体由一个分子表面包围，以球棍模型显示。与受体相互接触的区域，分子表面以原子的

颜色着色，灰色的区域是没有接触的。受体与配体相互作用的部分被显示为球棍模型和空间填充球。氢键以一

连串的小球显示。一个对话框可以被启动以提供了许多其他选项的可视化。Analyze>Macromolecule:打开一个

PDBQT 文件或选择一个已经输入到 PMV 中的大分子的选项。 

Grids>Open 

 Grids>OpenOther: 打开格点图文件以及启动 AutoDockTools 格点可视化界面。这一个对话框允许指定等高线和

多个渲染选项。等高线滑块和输入框限制能量在有利的范围内。“sampling”这个值用来产生对复合物图的粗略表

示。设置为 1，它使用实际的格点间距，设置为更高的值，抽取粗网格间距。在 PMV 菜单中的“Grid3D”工具也

是有更高级的格点可视化表示方法。 

Conformations>Play 

Conformations>PlayRankedByEnergy:打开一个窗口通过构象为步长来控制动画。“Play” 将会以对接计算发现的

构象按次序排序，以及 “PlayRankedByEnergy”将会按照从 低能量到 高能量排序。“&”按钮打开一个带有其
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他选项的窗口： 

ShowInfo 打开一个显示预测相互作用能，RMSD 等的信息面板。 

BuildHbonds 和 ColorbyATOM/vdW/elect/total  能可视化氢键以及相互作用能。 

PlayMode 和 PlayParameters 修改播放器的参数。 

BuildCurrent 在当前指定的播放器中，BuildCurrent 将会在观察器中对构象建立一组新的坐标。这对于将多种构

象显示在同一个观察器是有用的。BuildAll 将会在播放器中对所有的构象建立坐标。 

WriteCurrent 将会对当前播放器中的构象以 PDBQT 文件输出。 

WriteAll 将会对播放器中的所有构象以独立的 PDBQT 文件输出。 

WriteComplex  将会对当前播放器中配体和受体复合物构象以 PDBQT 文件输出。 

Conformations>Load: 启动一个交互式的浏览器，允许选择集群的对接构象。预测的相互作用能的信息显示在顶

部，以及单个构象可以在底部的面板中选择。“rank” 值可以给出 cluster_rank（聚类排序）——例如，“1_3”指的

是在 优聚类中的第三个 有利构象。底部的按钮可以通过扩大窗口显示，底部的按钮将会输出当前的坐标或

者关闭窗口。 

Clusterings>Show:这个工具用来显示集群构象的交互式直方图。 

Clusterings>Recluster:根据新的容差对对接的构象重新聚类。有数个可以用于重新聚类的标准值可在对话框中选

用。这个结果可用 Clusterings>Show 来分析。 

Clusterings>ReclusterOnSubset:只是用一组选定的原子重新集群对接的构象。这个选项可以使用 PMV 菜单中的

“select”工具来执行。
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附录Ⅰ：AutoDock 文件格式 

PDBQT 格式的坐标文件 

扩展名：.pdbqt 

“ATOM口口%5d口%-4s%1s%-3s口%1s%4d%1s口口口%8.3f%8.3f%8.3f%6.2f%6.2f%4s%6.3f口%2s \n",  

原子序号，原子名称，可变构象位点指示符，残基名称，链编号，残基序列号，插入残基的编号，x 坐标，y

坐标，z 坐标，位置因子，温度因子，脚注编号，局部电荷，原子类型 
（“口”符号用于表示一个空格。） 

相对于标准的 PDB文件来说， PDBQT文件中添加了四个项目： 

1) 在每个 ATOM和 HETATM记录的温度因子字段之后（第 67-76列）添加了原子的局部电荷的字段。

2) 在每个 ATOM 和 HETATM 记录的局部电荷字段之后（第 78-79 列）添加了用于描述原子类型的字段（一个
或两个字母）。 

3) 为了允许配体柔性，指定可旋转的键是有必要的。AutoDock 可以处理的可旋转键的数目 多为 MAX_TORS
（该参数已经被定义在“autodock.h”文件中），默认值为 32。如果该值发生了改变，就必须对 AutoDock 进行重新
编译。请注意，AutoDock4.2 目前对扭转自由度为约为 10（即 10 个可旋转的键）的系统非常有效，但对于那些具
有更大柔性的系统可能多次对接的结果并不一样。在 PDBQT 文件中定义的扭转，使用以下的关键词： 

ROOT / ENDROOT BRANCH / 
ENDBRANCH 

这里使用了树作为喻体。以下面的图解为例： “root（根）”被定义为配体的中心部分， 从它上面长出了可旋转
的“branches（分枝）”。而在分枝上又可能长出新的分枝。这些嵌套的可旋转键将按照从“叶子”到“根”的顺序依
次进行旋转。 对于这些 PDBQT 关键词的放置是需要慎重的，另外，为了使得各原子处于正确的分枝，有时候甚
至需要对 ATOM 和 HETATM 记录中的原子进行重新排序。AutoDockTools 就是为了帮助用户正确的放置这些关
键词而开发的，它同时还可以帮助我们对配体 PDBQT 文件中的 ATOM 和 HETATM 记录进行重新排序。 

4) 在构象熵的计算中会使用到总旋转自由度，它是通过使用 TORSDOF 关键词后加可旋转键的整数数目来指定
的。在目前 AutoDock 4.2 的力场中，这是配体中可旋转键的总数，包括像氢氧根以及其它基团中只有氢原子
能移动的旋转键，但不包括那些在环上的键。（对于环的柔性的计算请参考附录Ⅱ） 

注意：AutoDockTools，AutoGrid 和 AutoDock 并不识别 PDB 文件中的 “connect”记录，所以他们也不会把这
个记录输出到 PDBQT 等文件中。 
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REMARK 2 A betwee atoms CA_5 and
REMARK 3 A betwee atoms CA_5 and
REMARK 4 A betwee atoms CB_6 and
ROOT    

 

ATOM 1 CA PHE A 1 25.412 19.595 12.578 1.00 12.96 0.287
ENDROOT      
BRANCH 1 2    
ATOM 2 N PHE A 1 25.225 18.394 13.381 1.00 13.04 -0.065
ATOM 3 HN PHE A 1 25.856 17.643 13.100 1.00 0.00 0.275
ATOM 4 HN PHE A 1 25.558 18.517 14.337 1.00 0.00 0.275
ATOM 5 HN PHE A 1 24.247 18.105 13.350 1.00 0.00 0.275
ENDBRANC  1 2    
BRANCH 1 6    
ATOM 6 CB PHE A 1 26.873 20.027 12.625 1.00 12.45 0.082
BRANCH 6 7    
ATOM 7 CG PHE A 1 27.286 20.629 13.923 1.00 12.96 -0.056
ATOM 8 CD PHE A 1 27.470 22.001 14.050 1.00 12.47 0.007
ATOM 9 CE PHE A 1 27.877 22.571 15.265 1.00 13.98 0.001
ATOM 10 CZ PHE A 1 28.108 21.754 16.360 1.00 13.84 0.000
ATOM 11 CE PHE A 1 27.919 20.380 16.242 1.00 13.77 0.001
ATOM 12 CD PHE A 1 27.525 19.821 15.027 1.00 11.32 0.007
ENDBRANC  6 7    
ENDBRANC  1 6    
BRANCH 1 13    
ATOM 13 C PHE A 1 25.015 19.417 11.141 1.00 13.31 0.204
ATOM 14 O2 PHE A 1 24.659 20.534 10.507 1.00 12.12 -0.646

PDBQT 文件示例 
 
 

REMARK 4 active torsions: 
REMARK status: ('A' for Active; 'I' for Inactive) REMARK  1
 A between atoms: N_1 and CA_5 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

ENDBRANCH 1 13 
TORSDOF 4 
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REMARK 1 A between CA and CB 
REMARK 2 A between CB and CG 
ROOT    

 

ATOM 1 CA PHE A 53 25.41 19.595 12.578 1.00 12.96 0.180 C
ENDROOT     
BRANCH 1 2   
ATOM 2 CB PHE A 53 26.87 20.027 12.625 1.00 12.45 0.073 C
BRANCH 2 3   
ATOM 3 CG PHE A 53 27.28 20.629 13.923 1.00 12.96 -0.056 A
ATOM 4 CD1 PHE A 53 27.52 19.821 15.027 1.00 11.32 0.007 A
ATOM 5 CE1 PHE A 53 27.91 20.380 16.242 1.00 13.77 0.001 A
ATOM 6 CZ PHE A 53 28.10 21.754 16.360 1.00 13.84 0.000 A
ATOM 7 CE2 PHE A 53 27.87 22.571 15.265 1.00 13.98 0.001 A
ATOM 8 CD2 PHE A 53 27.47 22.001 14.050 1.00 12.47 0.007 A

BEGIN_RES ILE A 54 
REMARK 2 active torsions: 
REMARK status: for 'I' for Inactive) 
REMARK 3 A between CA and CB 
REMARK 4 A between CB and CG1 
ROOT  

 

ATOM 9 CA ILE A 54 24.457 20.591 9.052 1.00 12.30 0.180 C
ENDROOT   
BRANCH 9 10     
ATOM 10 CB ILE A 54 22.958 20.662 8.641 1.00 11.82 0.013 C
ATOM 11 CG2 ILE A 54 22.250 19.367 9.046 1.00 12.63 0.012 C
BRANCH 10 12     
ATOM 12 CG1 ILE A 54 22.266 21.867 9.298 1.00 13.03 0.002 C
ATOM 13 CD1 ILE A 54 20.931 22.246 8.670 1.00 14.42 0.005 C

用于表示柔性受体侧链的 PDBQT 文件格式 
 
 
受体的柔性侧链在 AutoDock 的模拟过程中会进行明确的处理。 AutoDock 需要一个单独的 PDBQT 文件来存放那
些被处理为柔性的侧链原子坐标。每一个残基的原子坐标和分枝关键词被放在 BEGIN_RES 和 END_RES 记录之
间。而那个把柔性侧链连接到蛋白质骨架上的原子（在模拟的过程中位置是固定的）将被视作“根”。那些在柔性侧
链 PDBQT 文件中包含的原子必须从记录刚性受体部分的 P D B Q T 文件中移去。例如，在下面的例子中，
苯丙氨酸残基的 α碳原子被用作柔性侧链的根。它将被包含在柔性侧链 PDBQT 文件中，而在刚性蛋白 PDBQT 文
件中将被略去。 
 
 
柔性侧链文件示例（具有两个柔性氨基酸残基） 
 
 
BEGIN_RES PHE A 53 
REMARK 2 active torsions: 
REMARK status: ('A' for Active; 'I' for Inactive) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ENDBRANCH 2 3 
ENDBRANCH 1  2 
END_RES PHE A 53 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ENDBRANCH 10 12 
ENDBRANCH 9 10 
END_RES ILE A 54 
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AutoGrid 格点参数文件：GPF（Grid Parameter File） 

扩展名： .gpf 

格点参数文件指定了 AutoGrid 的计算，包括盒子（box）的大小和位置、使用的原子类型、刚性受体部分坐标文
件以及其他用于格点计算的参数。不同于上一版本的 AutoGrid，现在成对的原子参数是从一个单独的文件（将在
下面描述）中读取的或采用 AutoGrid默认的参数。 
说明：在所有需要分隔符的地方均使用白空间（如空格、制表符等）；AutoDockTools 指定的默认值（如果存在的
话）都将在方括号中给出；一个注释的前面必须加上“#”号，注释可以放在参数行的尾部，也可以自成一行；尽
管理论上应该可以按任意的顺序来给出下面这些关键词，但并不是每一种组合都已经测试过，所以 好还是遵守
下面的顺序。 

AutoGrid 关键词和命令 

parameter_file  <字符串> 

(可选) 用户自定义的原子参数文件 (格式将在下面部分中描述)。默认地，A u t o G r i d 将使用内部（默认
的）参数。  

npts  <整数>  <整数>  <整数> 
[40, 40, 40] 

x 轴、y 轴和 z 轴方向上的格点数。这些值都必须是整数型数值。当加上中心格点以后，每一维的点数都将为奇
数。当然，这 3个方向上的格点数没必要一定相等。 

gridfld  <字符串> 

格点文件名，它将被以一种 AutoDock可读的格式写入。文件扩展名为“.fld”。 

spacing  <浮点数> 
[0.375 Å] 

格点间距，以 Å为单位。 在 AutoDock 中的格点是垂直且均匀间隔分布的，所以这个值在每一维都是统一的。 

receptor_types  <字符串> 
[A C HD N OA SA] 

存在于受体中的原子类型，以空格分隔。例如：对一个典型的蛋白来说，该值为“A C HD N OA SA”。原子类型
以一个或两个字母表示，在 AutoDock4.2 力场中还使用了一些特殊的原子类型，包括：C (脂肪链上的碳)，A (芳香
环上的碳)，HD (作为氢键供体的氢), OA (作为氢键受体的氧)， N (不作为氢键受体的氮)， SA (作为氢键受体的
硫). 

ligand_types  <字符串> 
[A C HD N NA OA SA] 
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存在于配体中的原子类型，以空格分隔，例如：“A C HD N NA OA SA”。 
 
 
receptor  <字符串> 

大分子文件名（PDBQT 格式文件）。 
 
 
gridcenter <浮点数> <浮点数> < 浮 点 数 > 
gridcenter auto 
[auto] 

用户可以分别指定盒子（box）中心的 x、y、z 坐标（单位均为 Å），从而明确的定义盒子的中心。或者我们也
可以使用关键词 auto 作为参数，在这种情况下 AutoGrid会以大分子的中心作为盒子的中心。 
 
 
smooth  <浮点数> 
[0.5 Å] 

成对的原子亲和势 (包括范德华力和氢键)的平滑参数。对于 AutoDock 而言，默认使用 0.5Å 这个值对力场进行了
优化。 
 
 
map  <字符串> 

每一种配体原子类型的格点文件名；扩展名通常是“.X.map”，“X”代表原子类型。在配体类型命令中，每一行都
包含了按照命令中指定的顺序排列的原子类型。 

 
elecmap  <字符串> 

将创建的静电势能格点文件名，文件扩展名为“.e.map”。 
 
 
dsolvmap  <字符串> 

将创建的去溶剂化势能格点文件名，文件扩展名为“.d.map”。 
 
 
dielectric  <浮点数> 
[-0.1465] 

介电函数标识符：如果为负数，AutoGrid会使用距离依赖性的 Mehler 和 Solmajer的电介函数；如果该浮点数是正
数，那么 AutoGrid 将使用这个值作为介电常数。AutoDock默认使用–0.1465这个值。 
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原子参数文件 

文件名：AD4.2_bound.dat 

对于原子参数，AutoGrid 和 AutoDock 默认使用内部值，也可以导入自定义的参数文件。该文件包含了自由能函数
中每一项的权重（即系数）以及每一种原子类型的参数。 

FE_coeff-vdW <浮点数> 
FE_coeff-hbond  < 浮 点 数 > 
FE_coeff-estat  < 浮 点 数 > 
FE_coeff-desolv  < 浮 点 数 > 
FE_coeff-tors <浮点数> 

以上为经验自由能力场中各项的权重参数。 

atom_par <字符串> 6*<浮点数> 4*<整数> 

每种原子类型的参数都是成对的。每条记录包括： 

1)原子类型。

2) Rii = 两个相似原子的范德华半径之和 (Å).

3) epsii = 范德华势阱深(kcal/mol)

4) vol = 原子溶剂化体积 (Å3)

5) Rij_hb = 杂原子与氢之间氢键的距离 (Å)，该值已经包含在杂原子记录中，相应的氢原子则被设置为 0。

6) epsij_hb = 氢键势阱深 (kcal/mol)

7) hbond = 用于指示氢键类型的整数

0，无氢键 

1，球形氢键供体  

2，定向的氢键供体           3， 

球形氢键受体 

4，定向的氢键 N 受体 

5，定向的氢键 O/S 受体 

8) rec_index = 初始化为-1，用于存储原子类型的数目

9) map_index = 初始化为-1，用于存储 AutoGrid图的索引

10) bond_index = 用于检测具有不同长度的键，详情请参考“mdist.h”
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atom_par H 2.00 0.020 0.0000 0.00051 0.0 0.0 0 -1 -1 3 # Non H-bonding Hydrogen 
atom_par HD 2.00 0.020 0.0000 0.00051 0.0 0.0 2 -1 -1 3 # Donor 1 H-bond Hydrogen 
atom_par HS 2.00 0.020 0.0000 0.00051 0.0 0.0 1 -1 -1 3 # Donor S Spherical Hydrogen
atom_par C 4.00 0.150 33.5103 -0.00143 0.0 0.0 0 -1 -1 0 # Non H-bonding Aliphatic 
Carbon 
atom_par A 4.00 0.150 33.5103 -0.00052 0.0 0.0 0 -1 -1 0 # Non H-bonding Aromatic 
Carbon 
atom_par N 3.50 0.160 22.4493 -0.00162 0.0 0.0 0 -1 -1 1 # Non H-bonding Nitrogen 
atom_par NA 3.50 0.160 22.4493 -0.00162 1.9 5.0 4 -1 -1 1 # Acceptor 1 H-bond Nitrogen
atom_par NS 3.50 0.160 22.4493 -0.00162 1.9 5.0 3 -1 -1 1 # Acceptor S Spherical 
Nitrogen 
atom_par OA 3.20 0.200 17.1573 -0.00251 1.9 5.0 5 -1 -1 2 # Acceptor 2 H-bonds Oxygen
atom_par OS 3.20 0.200 17.1573 -0.00251 1.9 5.0 3 -1 -1 2 # Acceptor S Spherical 
Oxygen 
atom_par F 3.09 0.080 15.4480 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Fluorine 
atom_par Mg 1.30 0.875 1.5600 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Magnesium 
atom_par MG 1.30 0.875 1.5600 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Magnesium 
atom_par P 4.20 0.200 38.7924 -0.00110 0.0 0.0 0 -1 -1 5 # Non H-bonding Phosphorus 
atom_par SA 4.00 0.200 33.5103 -0.00214 2.5 1.0 5 -1 -1 6 # Acceptor 2 H-bonds Sulphur
atom_par S 4.00 0.200 33.5103 -0.00214 0.0 0.0 0 -1 -1 6 # Non H-bonding Sulphur 
atom_par Cl 4.09 0.276 35.8235 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Chlorine 
atom par CL 4.09 0.276 35.8235 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding 

默认的原子参数文件 
 

# 
# Free Energy Coefficient 
# ------ 
FE_coeff_vdW 0.1662 
FE_coeff_hbond 0.1209 
FE_coeff_estat 0.1406 
FE_coeff_desolv 0.1322 
FE_coeff_tors 0.2983 

 
# 
# Atom Rii Rij_hb rec_index 
# Type epsii solpar epsij_hb map_index 
# vol hbond bond_index 
# -- ---- ----- ------- -------- --- --- - -- -- -- 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Chlorineatom_par Ca 1.98 0.550 2.7700 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding 
Calcium 
atom_par CA 1.98 0.550 2.7700 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Calcium 
atom_par Mn 1.30 0.875 2.1400 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Manganese 
atom_par MN 1.30 0.875 2.1400 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Manganese 
atom_par Fe 1.30 0.010 1.8400 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Iron 
atom_par FE 1.30 0.010 1.8400 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Iron 
atom_par Zn 1.48 0.550 1.7000 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Zinc 
atom_par ZN 1.48 0.550 1.7000 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Zinc 
atom_par Br 4.33 0.389 42.5661 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Bromine 
atom_par BR 4.33 0.389 42.5661 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Bromine 
atom_par I 4.72 0.550 55.0585 -0.00110 0.0 0.0 0 -1 -1 4 # Non H-bonding Iodine 
atom_par Z 4.00 0.150 33.5103 -0.00143 0.0 0.0 0 -1 -1 0 # Non H-bonding covalent map 
atom_par G 4.00 0.150 33.5103 -0.00143 0.0 0.0 0 -1 -1 0 # Ring closure Glue 
Aliphatic Carbon # SF             
atom_par GA 4.00 0.150 33.5103 -0.00052 0.0 0.0 0 -1 -1 0 # Ring closure Glue Aromatic 
Carbon # SF               
atom_par J 4.00 0.150 33.5103 -0.00143 0.0 0.0 0 -1 -1 0 # Ring closure Glue 
Aliphatic Carbon # SF 
atom_par Q 4.00 0.150 33.5103 -0.00143 0.0 0.0 0 -1 -1 0 # Ring closure Glue 
Aliphatic Carbon # SF 
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格点文件 

扩展名： .map 

每个格点文件的前六行存储着一些头部信息，它们描述了格点的空间特征以及使用的和创建的文件。这些文件
头部信息将被 AutoDock 校验，以确保它们适用于所要求的对接。 文件剩下的部分包含了格点的能量，以浮点数
的形式表示，每行一个。格点是以嵌套的循环 z(y(x)))来进行排序的，所以 x坐标变化 快。 

格点文件示例 

GRID_PARAMETER_FILE vac1.nbc.gpf 
GRID_DATA_FILE 4phv.nbc_maps.fld
MACROMOLECULE 4phv.new.pdbq SPACING 
0.375 
NELEMENTS 50 50 80 
CENTER -0.026 4.353 -0.038 
125.095596 
123.634560 
116.724602 
108.233879 
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格点的力场文件 

扩展名： .maps.fld 

实际上这是由两个文件组合成的一个文件。它既是一个 AVS 力场文件（可以被一些科学可视化程序读取），同
时也是 AutoDock 的输入文件（在文件开头的注释中有着 AutoDock 特有的信息）。 AutoDock 使用该文件来检
查它所读取的所有格点文件是否是兼容的。例如，在下面的示例文件中，格点间距为 0.375 埃，并且在每一维上
都有 60 个间隔（实际上是 61 个格点），盒子中心位于坐 标 (16, 39, 1)，它是在大分子“protein.pdbqt”附近进行
计算的，而 AutoGrid 参数文件则用于产生该格点，格点文件为“protein.gpf”。该文件还指向了另一个文件——
“protein.maps.xyz”，它包含了格点框在 x、y 和 z 三个维度上的 小和 大的范围。 后，列举了由 AutoGrid 计
算生成的格点文件，这里是 “protein.A.map”，“protein.C.map”等。 

格点文件示例 

# AVS field file 
# 
# AutoDock Atomic Affinity and Electrostatic Grids 
# 
# Created by autogrid4. 
# 
#SPACING 0.375 
#NELEMENTS 60 60 60 
#CENTER 16.000 39.000 1.000 
#MACROMOLECULE protein.pdbqt 
#GRID_PARAMETER_FILE protein.gpf 
# 
ndim=3       # number of dimensions in the field 
dim1=61   # number of x-elements 
dim2=61    # number of y-elements 
dim3=61    # number of z-elements 
nspace=3        # number of physical coordinates per point 
veclen=8        # number of affinity values at each point 
data=float            # data type (byte, integer, float, double) 
field=uniform    # field type (uniform, rectilinear, irregular) 
coord 1 file=protein.maps.xyz filetype=ascii offset=0 
coord 2 file=protein.maps.xyz filetype=ascii offset=2 
coord 3 file=protein.maps.xyz filetype=ascii offset=4 
label=A-affinity  # component label for variable 1 
label=C-affinity  # component label for variable 2 
label=HD-affinity    # component label for variable 3 
label=N-affinity  # component label for variable 4 
label=OA-affinity    # component label for variable 5 
label=SA-affinity    # component label for variable 6 
label=Electrostatics # component label for variable 7 
label=Desolvation    # component label for variable 8 
# 
# location of affinity grid files and how to read them 
# 
variable 1 file=protein.A.map filetype=ascii skip=6 
variable 2 file=protein.C.map filetype=ascii skip=6 
variable 3 file=protein.HD.map filetype=ascii skip=6 
variable 4 file=protein.N.map filetype=ascii skip=6 
variable 5 file=protein.OA.map filetype=ascii skip=6 
variable 6 file=protein.SA.map filetype=ascii skip=6 
variable 7 file=protein.e.map filetype=ascii skip=6 
variable 8 file=protein.d.map filetype=ascii skip=6 

AutoDock 对接参数文件：DPF 
扩展名：.dpf 
对接参数文件指定了AutoDock计算的文件和参数，包括用于对接的地图文件、配体分子的坐标文件和构象搜索

的参数文件。与上一版本的Autodock不同，此版本的AutoDock读取了成对原子的参数文件，用于计算分子的内

能。 

参数文件中空格表示分隔符。AutoDockTools指定的默认值用方括号表示，例如：[thus]。语句前有“#”的表示注释

语，用于解释说明此参数的意义，可以放在参数命令行的 后或者另起一行表示注释语。尽管你可以任意的使用

分隔符、方括号以及注释符的任意组合，但为了以后代码的阅读和维护，我们推荐按照以下方式编写参数代码。 
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设置多个输出文件的参数设置 
outlev <integer>                                                         命令行 
[1]                                                                        ADT默认值 
诊断输出信息。对于SA（模拟退火算法）：0表示无输出信息，1表示 小输出信息，2表示在每次循环计算后输

出全部信息，3表示在每个循环中的每步完成后输出详细信息。对于GA（遗传算法）和GA-LS（遗传算法-局部

搜索）：0表示 小输出，1表示输出每次遗传后的 小值、平均值和 大值，2表示输出每次遗传后的全部信

息。 
 
成对能量计算的原子参数设置 
parameter_file <string>                                                      
（可选）在计算分子内能量和配体与蛋白柔性侧链的结合能量时原子参数文件被调用。如果没有指定原子参数

文件，那么AutoDock将使用默认的参数文件AD4.2_bound.dat进行计算。 
 
Intelec                                                                                                                          
（可选）如果写入此关键词，将计算配体内部的静电势能；每对非成键原子的局部电荷将会提前计算出来，并

输出。注意，这仅仅对于柔性配体有用。 
 
intnbp_r_eps <float><float><integer><integer><string><string>                命令行 
（可选）此可选关键词允许用户手动替换指定的一组相互作用的内部势能。这些参数有req，ε，n，m和两种原子

类型，req指势阱的平衡距离，ε指势阱的深度，n和m都是系数。例如，命名为“intnbp_r_eps 1.5 10. 12 6 OA FE”表
示设置氧与铁原子之间1.5埃距离的相互作用势能的势阱为10 kcal/mol。势能V(r)计算公式如下： 

( ) / /

/ ( )

/ ( )

n m
n m

n
n eq

m
n eq

V r C r C r

C m n m r

C n n m r

ε

ε

= −

= − × ×

= − × ×

 

有一类特殊的原子类型“G”就是运用了此特性进行闭环模拟。请参阅Tutorial获得更详细的帮助。 
 
命令设置种子的随机数生成器 
seed <long_integer> 
seed time 
seed pid 
seed <long_integer> <long_integer> 
seed time <long_integer> 
seed <long_integer> time 
seed time pid 
seed pid <long_integer> 
seed <long_integer> pid 
seed pid time 
AutoDock具有两个随机数生成器库，一个使用C语言中的内部函数，另一个则是由德克莎斯州立大学生物医学学

院（UTBS）开发的便携式函数库。如果用户只是提供一个种子参数，那么AutoDock将调用系统安装的随机生成

器和相应的种子参数进行遗传算法的计算。大多数平台都是使用的“drand48”和“srand48”，但在UTBS数据库中需

要设定两个种子参数值。给定两个种子参数值是为了告诉Autodock为随机数生成器调用独立的函数库。基于

UTBS函数库的遗传算法和Solis&Wets算法都包含了两个种子参数值。但UTBS函数库不能用于模拟退火算法，如

果要使用模拟退火算法，则只能使用一个种子参数。每一次对接的随机数生成器都可以设定为用户自定义，定时

触发，或者是处理ID触发。如需要使用两个种子，那么触发规则可以自由组合（长整数），关键词为“time”或者

“pid”。关键词“time”设置的种子是基于当前的时间，而关键词“pid”设置的种子是基于UNIX系统当前正在执行

AutoDock程序的处理ID。 
 
格点地图的参数设置 
 
ligand_types <string> 
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配体中所有原子类型的原子名都用相同的空格分开，AutoGrid中原子类型使用一个或者两个字母。 
 
fld <string> 
AutoGrid产生格点数据文件（扩展名必须是“.fld”） 
 
map <file name> 
AutoGrid亲和力格点地图的文件名。此关键词后的文件名必须与“ligand_types”命令中定义的原子名及顺序一致。

地图文件中的前6行信息是必须的，并且能量值必须服从z( y( x ) )嵌套循环顺序。 
 
 
elecmap <file name> 
静电势格点地图文件名。地图文件中的前6行信息是必须的，并且能量值必须服从z( y( x ) )嵌套循环顺序。 
 
desolvmap <file name> 
file name是指去溶剂化格点地图文件。地图文件中的前6行信息是必须的，并且这些能量值必须以z( y( x ) )这样的

嵌套方式排列。 
 
非成键配体的状态参数设置 
 
(optional) unbound_energy <float> 
（可选）设置非成键内能值。 
 
(optional) unbound_model_extended 
（可选）执行此命令可获得一个配体的扩展构象，然后用此构象计算非成键状态的内能。Autodock4.0的关键词

“compute_unbound_extended”与此命令是一样的。 
 
(optional) unbound_model_extended_energy <float> 
（可选）此命令可设置未成键状态的内能值，也可设置默认原子参数，此参数用于评估成对能量值以适用于扩展

的未成键模型。 
 
定义配体及其初始态的参数 
 
move <file name> 
file name使用即将对接的配体的PDBQT坐标文件。 
                                 
about <float> <float> <float> 
[0.0 0.0 0.0] 
此关键词用于设定配体的中心，配体可以此中心旋转。（参考的坐标系就是配体的PDBQT文件。）通常，配体

的可旋转中心坐标设置为x，y，z，单位都是埃（Å）。 
 
tran0 <float> <float> <float> 
tran0 random 
[random] 
此关键词设置在与受体格点地图一样的参考坐标系下，初始化配体中心的坐标。 
 
另外，用户可以只使用“random”关键词，AutoDock将会随机选定初始化坐标。 
 
在每一次计算之前，用户必须指定为配体指定起始的绝对坐标。用户必须保证配体不管如何变化都在格点地图的

范围之内。如果配体上有一些原子因配体旋转后而跑到了格点地图之外，那么AutoDock将自动修正，直到配体

被完全拉入回格点地图范围内。（这样做是为了得到完整的系统的初始化状态的能量信息。） 
当出现如上的情况时，AutoDock程序将会告知用户。（单位：Å, Å, Å.） 
 
quat0 <float> <float> <float> <float> 
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quat0 random 
[random] 
分别为：Qx, Qy, Qz, Q。初始化轴线角的取向（针对配体）—Qx, Qy, Qz定义了刚性配体旋转的方向的单位矢

量，Q则定义了单位矢量的旋转角度，单位为“°”。（单位：none，none，none，°.） 
 
另外，用户可以只使用“random”关键词，AutoDock将会选择一个随机单位矢量和随机旋转角度（介于0-360°之
间）。在对接参数文件中指定的每一次对接模拟将以这些随机刚性构象为旋转的起始点。 
 
dihe0 <float> ... 
dihe0 random 
[random] 
此关键词初始化相对二面角角度值。在PDBQT文件中的每一个可旋转键的初始二面角角度必须设置为浮点数。

在每次计算开始时，每个指定的二面角初始值将会被添加到PDBQT输入文件中对应的二面角值中。二面角的值

只需要两个原子就可以确定，因此配体旋转的定义是相对与配体的输入构象，而非其绝对构象。单位为“°”
（度）。 
 
 
定义配体在模拟退火计算中每步大小的参数 
 
tstep <float> 
tstep <float> <float> 
[2.0 Å] 
第一种形式，定义配体在一次模拟退火步骤的第一个循环中 大的跳跃距离。当“trnrf”小于1时，在每个循环结

束后将递减系数乘以tstep的值赋予下一次循环。第二种形式允许用户指定第一个和 后一个循环得到的值：

AutoDock将计算满足这些约束的递减系数。单位为：埃（Å）。 
 
qstep <float> 
[50.0°] 
设置定向组份的 大步长的角度。单位为：度（°）。 
 
dstep <float> 
[50.0°] 
设置 大步长的二面角（或扭转角）角度。单位为：度（°）。 
 
定义可选配体扭转角约束的参数 
 
barrier <float> 
[10000.0] 
（可选）此关键词定义了能垒高度来约束扭转角。当扭转角在一个理想的角度时，将没有扭转角罚分：此扭转角

能量为零。但是，如果当扭转角角度在一个不适当的区域内，这将产生扭转角能垒。因此，扭转角能量文件以

“unsigned short”数组形式储存，数组的值限于0-65535的正整数。 
 
gausstorcon <integer> <float> <float> 
（可选）为扭转角添加限制条件。Integer（整数）定义扭转角数目。这个数值来源于AutoDockTools生成的配体

PDBQT文件中顶部的列表（REMARK行）。计算得到此扭转角的能量，然后一个反向高斯计算将会被添加到每

个新的限制条件中。为了指定每个高斯计算，必须设定两个浮点数值：一个理想全角和一个半角。值得注意的是

理想角度应该在-180° 到+180°这个范围内，超出这个范围的值将会自动被带回这个范围。此全角χ是与输入结构

中的初始扭转角相关的。半角则是两个角之间的能垒值一半的角度。半角越小，限制得越严。 
如果你希望限制扭转角的绝对值，你必须把配体的初始扭转角归零。如果只定义B-C可旋转键中的2个原子，这

将会使扭转角不明确。为了定义一个明确的扭转角则必须同时指定4个原子，如：A-B-C-D。 
我们这样定义扭转角的正负值：逆时针为正值，顺时间则为负值。从上往下看B-C键，那么A-B-C-D二面角为正

值。 
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软件并没有限制扭转角约束条件的个数。每个新的扭转角-约束能量值是综合了之前的 低能量扭转角和现在的

或者已经存在的能量值。 
值得注意的是在我们的测试中，扭转角约束条件非常低效，或者仅仅当配体只有几度的旋转时有效，或者只有几

个扭转角约束的时候有效。 
 
showtorpen 
（可选）仅和“gausstorcon”同时使用。此关键词控制扭转角能量的存储与输出。在每次能量计算中，执行

“gausstorcon”命令后每个被约束的扭转角将被罚能量，结果被储存在数组里。每次运算后， 后的对接构象将会

以变量的形式输出。但是，如果使用此关键词（命令），除了扭转角的角度，每个扭转角被罚的能量将会在屏幕

上显示出来。 
 
对接后构象的聚类分析参数设置 
 
rmstol <float> 
[2.0Å] 
当指定的对接计算完成后，AutoDock将采用全原子的均方根偏差值（RMSD）对结果进行分类，并按照能量的递

增顺序排列。每个分类中 低能量的构象被记录在PDBQT格式的log文件中。为了在PDBQT文件中保留配体的序

号，可以使用“-k”标记，否则分类的构象将会自动从1开始编号。（单位为：埃） 
 
rmsref <filename> 
（可选）使用此关键词，则指定的参考分子与对接后构象的均方根偏差值（RMSD）将被计算。当已知实验测定

的晶体复合物中配体的构象时，这样做是非常有用的。“MOVE”命令将使对接后构象的原子顺序与参考配体的原

子顺序相匹配。当构象的聚类计算完成后，均方根偏差值（RMSD）将被写入PDBQT文件的 后一行。如果不使

用此命令，那么均方根偏差值（RMSD）的计算将以第一个对接后构象（能量 低的构象）作为参考分子。 
 
rmsnosym 
（可选）结构分类的默认方法是允许原子有相似，比如叔丁基可以旋转+/-120度，但在其他情况下，忽略原子类

型的相似而直接计算两分子的均方根偏差值也是可取的。对称检测算法扫描参考分子所有原子的坐标，然后选择

离得 近的相同类型的原子计算它们之间距离，得到总的距离的平方和。当两个构象非常相似的时候，对称检测

算法很管用，但当两个构象有显著的不同时，此算法就失效了。 
使用“rmsnosym”命令可以关闭对称检测，如果你想一直使用对称检测，那么只需省略此命令。 
 
rmsatoms all 
（可选）如果使用此命令，配体和受体柔性残基原子的均方根偏差值将会被计算。 
如果参考的配体文件被指定，那么此文件必须包含配体和受体柔性残基原子的坐标。 
 
格点外原子的能量参数设置 
 
extnrg <float> 
[1000.] 
此命令将额外的格点能量分配给在对接时流浪在格点体积外的原子。 
 
配体的能量计算参数设置 
 
epdb 
此命令用于计算配体的结合自由能。特别是用于计算特定的配体构象的能量，而不需要做对接计算。 
 
模拟退火算法的构象搜索参数设置 
e0max <float> <positive_integer> 
[0., 10000] 
此命令设定配体初始状态的能量不能高于第一个设定值（float），也不能超过第二个值设定的重试次数。通常能

量值在0~1000 kcal/mol这个范围。如果初始能量值超过这个值，系统将重新随机产生构象并计算其能量。这个过



45

 
 
 
 

生物分子模拟论坛                                                                                                                                                                          www.bioms.org 

 

程将反复进行，直到满足设定的条件。这将有效防止构象搜索开始于一个高能构象区。在这种被限制的情况下，

配体可以被困住，因为它不能做足够长的翻转跳跃。在这些格点中的配体足够的小，可以轻松的适应于低能区

域，因此在有利的位置不会有过多的迭代计算。但是，在高度限制的格点中，对于大的配体而言，这个初始化的

循环可能是遥遥无期的。 
 
rt0 <float> 
[500. cal/mol]. 
此命令是初始化退火的温度；此温度实际上是绝对温度乘以气态常数R。R=8.314Jmol-1K-1=1.987calmol-1 K-1。

（单位：cal mol-1。） 
 
rtrf <float> 
此命令是设置退火温度下降因子，g[0.95 /循环]。在每次循环完成后，退火温度将乘以此因子，然后以此结果进

入下一个循环。为了使系统冷却，此因子必须是正值，且小于1。建议逐渐冷却降温，以避免“模拟淬火”现象发

生，导致陷入系统的局部 小值。 
 
linear_schedule 
schedule_linear 
linsched 
schedlin 
这些关键词是同义词，它们可以让AutoDock采用线性或者算术的温度递减列表进行蒙特卡罗模拟退火计算。除

非使用此关键词，否则rtrf参数描述的几何递减列表将会被运用。如果线性列表被应用，那么rtrf参数将会被忽

视。模拟退火的第一个循环将在退火温度为rt0（设置的初始温度）下进行。在每次循环结束后，温度将会降低

（rt0/循环）。线性温度递减列表的优点是系统的样本均匀的分布在温度轴两侧，这在计算熵的时候非常重要。

与线性列表不同的是几何温度递减列表中轴线下的样本升高温度，轴线上的样本则降低温度。 
 
runs <integer> 
[10] 
此命令设置自动对接的次数。 
 
cycles <integer> 
[50] 
此命令设置温度降低循环的次数。 
 
accs <integer> 
[100] 
此命令设置每次循环可接受步数的 大值。 
 
rejs <integer> 
[100] 
Maximum number of rejected steps per cycle. 
此命令设置每次循环不可接受步数的 大值。 
 
select <character> 
[m] 
此命令设置状态选择的标记。此字母可以是m（表示 小状态），也可是I（表示每次循环的 后状态）。这些状

态将作为下一个循环的起始状态。 
 
trnrf <float> 
[1.0] 
此命令设置翻转步骤中的每次循环递减因子。 
 
quarf <float> 
[1.0] 
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此命令设置定位步骤中的每次循环递减因子。 
 
dihrf <float> 
此命令设置扭转二面角步骤中的每次循环递减因子。 
 
遗传算法，拉马克遗传算法和进化程序搜索的参数设置 
 
ga_pop_size <positive_integer> 
[150] 
此命令是设置种群中个体的数目。每个个体都是由基因型和相关的表型组成的复合体。此值的通常设置为

50~200。 
 
ga_num_evals <positive_integer> 
[2500000] 
此命令设置在遗传算法计算过程中能量评定的 大次数。 
 
ga_num_generations <positive_integer> 
[27000] 
此命令设置在遗传算法或者拉马克遗传算法计算过程中模拟代数的 大次数。 
 
ga_elitism <integer> 
[1] 
此命令在遗传算法的选择机制中使用。此整数值设置了 优的个体数，这些个体将进行下一代繁殖。 
 
ga_mutation_rate <float> 
[0.02] 
此命令设置遗传算法中的突变概率，数值为0~1，此参数通常设置得比较小。 
 
ga_crossover_rate <float> 
[0.80] 
此命令设置了遗传算法中的交叉概率，数值为0~1。交叉概率是指在种群中预计成对数，成对的个体将交换其基

因。设置此数值为0，寻优编程则是采用遗传算法，但是寻优编程可能需要增加遗传算法的突变率才能有效。 
 
ga_window_size <positive_integer> 
41 
[10] 
此命令设置了前代的数量，为了去掉现在的种群中 差的个体而设置了这个阀值。 
 
ga_cauchy_alpha <float> 
[0.0] 
ga_cauchy_beta <float> 
[1.0] 
此二命令在实数基因的突变中设置了两个浮点参数。这两个数字对应了柯西分布中的α和β参数。α粗略的对应平

均值，β则是分布方差。尽管柯西分布没有有限方差，但也必须注意这一点。由于实数型基因的突变，产生了柯

西偏离，然后添加进了原始值中。 
 
Genetic algorithm parameters 
遗传算法参数 
set_ga 
此命令设置了遗传算法的全局优化。当然，这需要进行遗传算法搜索。这是通过带有“ga_”参数来指定全局优化

目标。如果此命令被省略，或者把它放在“ga_”参数的前面，系统将采用默认值去优化，而你设置参数将不会起

作用。 
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如果要使用传统的（非拉马克）遗传算法，请不要指定局部搜索参数，也不要使用“set_sw1”或者“set_psw1”命
令。 
 
如果要使用拉马克遗传算法，你必须为局部搜索指定参数，然后还要使用“set_sw1”或者“set_psw1”命令。

“set_sw1”命令使用严格的Solis和Wets局部搜索算法，“set_psw1”命令则使用伪Solis和Wets算法。（见下面内容） 
 
局部搜索的参数设置 
 
sw_max_its <positive_integer> 
[300] 
此命令设置了迭代的 大次数，迭代在局部搜索过程中可以用于任何给定个体的显型。 
 
sw_max_succ <positive_integer> 
[4] 
此命令设置了在Solis和Wets算法中由“rho”参数导致变化之前的一行中的成功数。此成功数是一个无符号的整

数，通常设置为4。 
 
sw_max_fail <positive_integer> 
[4] 
此命令设置了在Solis和Wets算法的“rho”参数判断前的一行中的失败数。此失败数是一个无符号的整数，通常设

置为4。 
 
sw_rho <float> 
[1.0] 
这是Solis和Wets算法的参数。它定义了初始变量，并且为样品指定了局部空间的大小。 
 
sw_lb_rho <float> 
[0.01] 
此关键词定义了rho的下界，也是基因改变的方差（例如：配体的翻转，取向，扭转）。rho不能设置得比

“sw_lb_rho”还小。 
 
ls_search_freq <float> 
[0.06] 
此关键词设置了提交局部搜索的特定显型基因的可能性。 
 
选择和设置局部搜索方法的命令 
 
“set_sw1”和“set_psw1”两命令通过带有“sw_”的参数来进行局部优化。如果你忘记使用此命令，或者在“sw_”关键

词后使用它，你的选择将会失效，系统将使用默认值进行优化。目前，psw1方法是表现 好的，并且也被系统当

作默认值使用。 
 
set_sw1 
此关键词让AutoDock使用经典的Solis和Wets局部搜索，运用统一方差的方法去让配体的翻转，改变取向和扭

转。 
 
set_psw1 
此关键词让AutoDock使用伪Solis和Wets局部搜索。此方法保持了配体翻转（变化为多少Å）和旋转（变化为多少

弧度）方差的相对比例。此变化与初始构象比通常变化了0.2Å和0.087弧度。因此翻转的方差（变化）一般是大

于旋转方差（变化）的2.3倍。（例如：配体的取向和扭转）。 
 
指定搜索方法的命令 
 
simanneal 
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此命令指定AutoDock使用模拟退火（SA）搜索引擎进行对接的次数。使用“runs”关键词设定的次数作为模拟退火

对接的运行次数。在这之前首先要设置好模拟退火搜索的参数。 
 
在上面的每个关键词的描述中都暗含了[SA]。 
 
do_local_only <integer> 
[50] 
此关键词让AutoDock执行对接的时候仅使用全局-局部搜索中的局部搜索。除了种群数的大小，遗传算法其他参

数会被忽略。用与对接计算同样的力场去优化配体是一个不错的方法。也不需要使用“ga_run”关键词。此关键词

后面的数字设置了需要进行局部搜索的次数。 
 
do_global_only <integer> 
[50] 
此关键词让AutoDock执行对接的时候仅使用全局搜索，如传统的遗传算法。局部搜索参数会被忽略，也不需要

使用“ga_run”关键词。此关键词后面的数字设置了需要对接的次数。 
 
ga_run <integer> 
[10] 
此命令调用了拉马克遗传算法的搜索引擎，并执行需要对接的次数。所有适合的参数都必须在前面加上“ga_”。 
 
对接后构象聚类分析的命令 
analysis 
此命令是对分子对接的结果进行聚类分析，然后把结果写入log文件。对接后的构象按照能量降低的方式排列，

然后比较他们的均方根偏差值。出现的柱状图中显示了每个类别中的构象数目，如果此类别中不止一个构象，那

么显示的能量是平均值。此外，log文件中还保存了均方根偏差值表，包含聚类的均方根偏差值和与参考分子的

均方根偏差值。 
 
附录 2 利用 AutoDock 对接柔性环 
1.引言 
 
AutoDock 不能直接处理环状分子中的键的柔性，这导致了配体中的环状部分被认为是刚性的。有许多方法可以

用于对接大环分子，比如识别出环状部分的低能构象并将它们作为不同的配体进行对接。但是派生这些构象并且

分别的进行对接是一个耗时耗力的工作。作为一种解决方式，一种间接的方法可以使得环状结构作为全柔性部分

进行处理，并且利用遗传算法探索它的柔性。这种方法 早在 3.05 版发展，并在 4.2 版正式应用。这种方法通过

移除环状结构中的一个键使得环状部分转化成对应的非环状结构，然后将处于开环状态的结构进行全柔性对接。

在 AutoDock 中存在特殊的原子类型定义可以储存原始的环状结构，并且利用遗传算法进行环形结构的构象探

索。这一方法可以被分为以下三步： 
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(a) 开环：通过移除一个键，使得配体转变成无环结构。 

 
(b) 配体前处理：配体通过标准的 AutoDockTools 步骤进行处理，但是边缘原子被 G 原子所取代。 
 
(c) 对接及环闭合：配体对接时应用一个虚拟的 12-2 莱纳德-琼斯势函数进行处理 G 原子用于储存环状结构。 
 
 
为了保存闭合的环状结构坐标，一个自定义的长程虚拟的莱纳德-琼斯势函数用于约束对接过程中的这些原子。

这一莱纳德-琼斯势函数在长程仍然有效，确保即使是大环化合物也能有效的环闭合。 
 

 
 
环闭合参数：比较标准的 12-6 范德华相互作用，12-10 氢键相互作用以及 12-2 拟莱纳德-琼斯势函数，在

AutoDock 的平滑函数应用之前。 
 
对于 G 原子来说，没有额外的 map 文件被派生出来，因为在评价受体-配体结合的过程中，它们被作为正常的碳

原子处理。然后，C 原子的 map 文件被使用。在对接过程中，这一势函数使得环结构可以有效的闭合，使得遗传

算法可以正常的用于环构象的探索。 
 

1) 柔性环 
开环 

为了把分子转换成开环形式，必须找到要打断的那个键。如何获得开环形式将会影响到后续环的闭合。如果想

在移去某个键后使得计算简单且 终结果的质量得到提高的话，下面的指南可能会对你有所帮助： 

 
保持较少的可旋转键数目 
开环将会显著增加可旋转键的总数，从而导致计算时间变长。 因此，当柔性较弱或者具有部分
刚性的区域存在时，不应该把它们打断。那些被打断后产生的链较短的键应当被优先考虑。 
 
打断 C-C 键 
出于对计算结果可重复性的考虑，被打断的键应该位于两个相同类型原子之间。 AutoDock 支持
脂肪族和芳香族的 C 原子。我们也可以打断非 C 原子间的键，但这将会需要设置特殊的参数。 
(见 4.扩展和局限性) 

 
避免手性原子 (...只要可以的话) 
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= ----------- - ----------- 
G,G 12 2 

r r 

由于氢原子缺乏方向性和在统一原子模型中的描述，如果位于一个或者更多手性碳原子之间的键
被打断后将无法保证恢复到原有的手性。当环上所有的 C 原子都具有手性时(如天然化合物，抗
生素)则打断哪个键都无所谓了，然而在这种情况下需要检查对接结果中各原子的手性，并且手
动校正（如果有必要的话）。 
 
一旦环被打开，在 PDBQT 文件中的原子类型列中将把之前相连的那两个原子更名为“G”。 

 
 

[...]  

HETAT
M 

21 CD4 UIN B 100 -2.919 22.061 19.604 1.00 19.90 0.005 G 

[...]      

HETAT
M 

24 CD3 UIN B 100 -3.821 22.402 20.791 1.00 19.60 0.005 G 

[...]      

 

12-2 势能被定义在 DPF 文件中，它通过使用 intnb_r_eps 关键词来改写 AutoDock 内部的相互作用参数列表，语

法如下： 
 
 
 
intnbp_r_eps 1.51 10.000000 12 2 G G 
 
 
AutoDock 将会在 DLG 文件中生成新的参数： 
 
 

Ring closure distance potential found for atom type G : Equilibrium distance
 = 1.51 Angstroms 
Equilibrium potential = 10.000042 Kcal/mol Pseudo-LJ 
coefficients = 12 - 2 

 
 

Calculating internal non-bonded interaction energies for docking calculation; 
 

Non-bonded parameters for G-G interactions, used in internal energy calculations: 
 

281.0 27.4 
E 

 
 
 

多于一个环时 

通过打断每个环上一个键并让这些断点处原子更名为不同的原子类型，就可以对含有多个柔性环的配体进行对

接。AutoDock 中包含了四种可用于闭环的 C 原子类型：G, J, Q (脂肪族的)和 GA (芳香族的)，所以可以对接

多含有四个柔性环的配体分子。例如，如果我们打开了第二个环，那么新生成的断点处原子将被更名为 J，同

时 DPF 文件将会包含一个额外的 intnb_r_eps 关键词以及另一个 C map 的作为参考。 AutoDock虽然没有明确的

限制配体分子中可被开环数目，但实事它对分子的柔性是有限制的，如 大可旋转键的数目为 32。如果要定义

更多的原子类型(例如 -S-S- 二硫键)，就必须生成一个自定义的原子参数文件并且通过 parameter_file 关键词把它

引用到 DPF中。 

 
局限性 

与让配体生成大量的刚性环构象然后与蛋白对接相比，上述柔性环对接方法可以节省大量时间，但该方法也存

在着一些局限性。 
 
 
手性。由于在 AutoDock 并无氢原子的的统一原子模型，当结合在手性原子旁边的氢原子被合并时原子手性信
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息将丢失。在对接的过程中，G 原子 后可以从与原始构型不同的的方向相互结合， 终可能会导致错误

的手性。 
 
 
键长。伪伦纳德-琼斯势函数（pseudo-Lennard-Jones potential）参数描述了两个 G 原子之间的理想平衡距离，

与平衡的 C-C 键长 (约 1.5 Å)相一致。然而由于两个原子之间存在的范德华斥力阻止了原子体积的重叠，这可能

会导致 终的键长稍微大一些。 
 
 
能量计算。在计算的过程中，伪伦纳德-琼斯势函数（pseudo-Lennard-Jones potential）提供了对总能量贡献的额

外的能量，以介导环的闭合。这会导致 终的能量总值下降低到一个稍低的水平。这虽然还算不上真正的局

限性，但是我们应当尽量避免把在不具有柔性环和具有柔性环条件下的对接得分进行比较。 
 
 
由于以上这些原因， 我们需要对 后的对接结果进行优化，包括检查手性以及进行构型的优化来校正键角和

键长。 
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下面是与引言中示例结构相对应的 DPF 文件： 
 
 
 
autodock_parameter_version 4.1 # used by autodock to validate parameter set outlev 1 # 
diagnostic output level 
intelec # calculate internal electrostatics 
seed pid time # seeds for random generator 
ligand_types A C G HD OA # atoms types in ligand 
fld protein.maps.fld # grid_data_file 
map protein.A.map # atom-specific affinity map 
map protein.C.map # atom-specific affinity map 
map protein.C.map # C map fir G atoms 
map protein.HD.map # atom-specific affinity map 
map protein.OA.map # atom-specific affinity map 
elecmap protein.e.map # electrostatics map 
desolvmap protein.d.map # desolvation map 
intnbp_r_eps 1.51 10.000000 12 2 G G # pseudo-LJ potential 
move ligandG.pdbqt # small molecule 
about -0.8665 18.5882 20.1623 # small molecule center 
tran0 random # initial coordinates/A or random 
quat0 random # initial quaternion 
dihe0 random # initial dihedrals (relative) or random 
tstep 2.0 # translation step/A 
qstep 50.0 # quaternion step/deg 
dstep 50.0 # torsion step/deg 
torsdof 8 # torsional degrees of freedom 
rmstol 2.0 # cluster_tolerance/A 
extnrg 1000.0 # external grid energy 
e0max 0.0 10000 # max initial energy; max number of retries 
ga_pop_size 350 # number of individuals in population 
ga_num_evals 2500000 # maximum number of energy evaluations 
ga_num_generations 27000 # maximum number of generations 
ga_elitism 1 # number of top individuals to survive to next 
generation 
ga_mutation_rate 0.02 # rate of gene mutation 
ga_crossover_rate 0.8 # rate of crossover 
ga_window_size 10 # 
ga_cauchy_alpha 0.0 # Alpha parameter of Cauchy distribution 
ga_cauchy_beta 1.0 # Beta parameter Cauchy distribution 
set_ga # set the above parameters for GA or LGA 
sw_max_its 300 # iterations of Solis & Wets local search 
sw_max_succ 4 # consecutive successes before changing rho 
sw_max_fail 4 # consecutive failures before changing rho 
sw_rho 1.0 # size of local search space to sample 
sw_lb_rho 0.01 # lower bound on rho 
ls_search_freq 0.26 # probability of performing local search on individual 
set_sw1 # set the above Solis & Wets parameters 
unbound_model bound # state of unbound ligand 
ga_run 100 # do this many hybrid GA-LS runs 
analysis # perform a ranked cluster analysis 

 
 
2) 参考文献 

 
 
Forli, S., et al. J. Chem. Inf. Model., 2007, 47, 1481–1492 

 
3) 柔性环对接教程 

 
 
http://autodock.scripps.edu/faqs-help/tutorial/flexible-rings-docking 
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附录Ⅲ：AutoDock 参考文献 
 
 
AutoDock 4.2 

 
 

Morris, G. M., Huey, R., Lindstrom, W., Sanner, M. F., Belew, R. K., Goodsell, D. S. and Olson, 
A. J. (2009) J. Comput. Chem. in press. “Autodock4 and AutoDockTools4: automated docking with 
selective receptor flexiblity.” 

 
 
AutoDock 4.0 

 
 

Huey, R., Morris, G. M., Olson, A. J. and Goodsell, D. S. (2007) J. Comput. Chem. 28, 1145- 1152. 
“A semiempirical free energy force field with charge-based desolvation.” 

 
 

Huey, R., Goodsell, D. S., Morris, G. M. and Olson, A. J. (2004) Letters in Drug Design and 
Discovery 1, 178-183. “Grid-based hydrogen bond potentials with improved directionality”. 

 
 
AutoDock 3.0 

 
Morris, G. M., Goodsell, D. S., Halliday, R.S., Huey, R., Hart, W. E., Belew, R. K. and Olson, 

A. J. (1998), J. Computational Chemistry, 19: 1639-1662. "Automated Docking Using a Lama- 
rckian Genetic Algorithm and and Empirical Binding Free Energy Function". 

 
 
AutoDock 2.4 

 
Morris, G. M., Goodsell, D. S., Huey, R. and Olson, A. J. (1996), J. Computer-Aided Molecular Design, 
10: 293-304. "Distributed automated docking of flexible ligands to proteins: Parallel applications of 
AutoDock 2.4". 

 
Goodsell, D. S., Morris, G. M. and Olson, A. J. (1996), J. Mol. Recognition, 9: 1-5. "Docking of 
Flexible Ligands: Applications of AutoDock". 

 
 
AutoDock 1.0 

 
Goodsell, D. S. and Olson, A. J. (1990), Proteins: Str. Func. and Genet., 8: 195-202. "Auto- mated 

Docking of Substrates to Proteins by Simulated Annealing". 
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版权申明 

 

本翻译版的 AutoDock 说明书版权归生物分子模拟论坛（www.bioms.org）所有，任何团体和

个人不得未经允许擅自转载本翻译教程的全部或部分内容，如有发现，本论坛保有追究其法律责

任的权利。 

                                                             2012-11-20 

                                                             BioMS 小组 
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